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Abstract 

The competitive nature of team sports requires the collection and tracking of 

game statistics in order to provide not only comparisons of scores to determine the 

winner of a game, but also to compare individual team member performance.  Football, 

baseball, hockey, bowling, and many other games generate statistics that had been 

tracked and calculated by hand.  With the widespread availability of computers, software 

programs have been created to track and calculate team and individual statistics for 

league and tournament play for different sports.  This document reviews the design and 

creation of a software package to track and calculate team and individual statistics for the 

sport of trap and skeet shooting.  It addresses the need for such a package, requirements 

of the software, cost analysis of design and programming, the structure of the program, 

and how the program objectives were met. 
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PerfectShot: Trap and Skeet League Manager 

 

1. Problem Statement 
 
 Before the computers, performance statistics had been tracked and calculated by 

hand.  With the widespread availability of computers, a market for software that would 

do the calculations and keep track of statistics was opened.  Several software packages 

are available for a number of team or individual sports.  WinBowl Tenpin League 

Manager for bowling leagues, Golf-IT for small golf leagues, Baseball StatWiz 2000 for 

baseball teams, Tennis Captain for tennis leagues, Golden Goal for soccer leagues, and 

SNAPSHOT! Hockey Statistics Manager for hockey leagues are only a few of the 

programs available to aid the league manager in tracking a teams’ and individual’s 

performance throughout a league season. (2) 

 Research shows that there are few specific programs available for the sport of trap 

and skeet shooting.  Using the World Wide Web and most of the available search engines 

(Go, Yahoo, WebCrawler, Lycos, AltaVista, MSN Search) to search for commercially 

available software for this sport ended in zero results.  Using the keywords of SKEET, 

TRAP, LEAGUE, and SOFTWARE produces results that include games, league software 

for other sports, Web sites for skeet shooting clubs and the celebrity Skeet Ulrich.   

However, a search on Google.com resulted in four Web site matches for skeet 

software that was not game oriented.  One site apparently belonged to a University of 

North Carolina student who did a similar project.  Unfortunately, this site and one other 

were no longer available.  The other two Web sites eventually led to the same web site 

through a chain of links.  This Web site, http://www.skeetsoftware.com, belongs to 
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Michael Valerio who has written a software package specifically for tracking skeet 

tournament results, including the calculation of prize money won by each team and 

shooter.  This program was written using Visual Basic 6.0 as a front-end interface for a 

Visual Fox-Pro application. (8) Although this program incorporated the goals capabilities 

planned for this project, it was written specifically for tournament play not league play 

and, therefore, does not meet the needs of a user organizing a league. 

 Interviews with local, state, and national skeet shooting organizations have shown 

that such a software package is not in general or widespread use.  According to Don 

Snyder of the National Skeet Shooting Association, most league managers use personally 

created spreadsheet programs to record and track league statistics. (7) While this may be 

sufficient for some people, other people may not know how to create spreadsheets or 

program macros to calculate the required statistics.  Thomas Niner, who runs a skeet 

league at a small trap and skeet range in northern Ohio, states that he has created a Lotus 

spreadsheet for his league, but it causes memory resource problems with his computer as 

the size or number of leagues increase. (6) As an accepted Olympic level sport, skeet 

shooting is gaining in popularity throughout the United States. In 1999, surveys by the 

National Skeet Shooting Association and the Amateur Trapshooting Association showed 

that they were 2 million skeet shooters and 3 million trap shooters in the United States 

and Canada. (7) With skeet leagues being formed at all times of the year, the need for a 

user friendly program to aid the league manager in tracking league and match results 

seems apparent. 
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2. Proposed Solution 
 
 To solve this problem I designed and created a software package to fulfill the 

needs of the average league manager in tracking league match results and calculating 

statistics such as handicaps and league leaders.  Users targeted by such a program are trap 

and skeet range managers, league organizers, league managers, league record keepers, 

and shooters wishing to track league results on their own.  This program required specific 

guidelines and goals.  Thomas Niner provided a list of requirements that such a program 

should meet and which I used as the basis of my program design. 

According to Mr. Niner, the program must: 

• Provide capability to store individual scores 
• Provide capability to store team scores 
• Provide team and individual relationship 
• Provide capability to calculate handicaps where required 
• Provide capability to schedule league matches throughout the league season 
• Allow individuals to belong to more than one league 
• Provide capability to print league schedules, match results, and league standings 
• Provide capability to store individual contact information.  (6) 
 

To meet these requirements, the program was constructed as an interface for a 

Microsoft Access database.  The database provides an organizational format and storage 

capability for league data.  The interface, through use of the ADO commands, interacts 

and manipulates the database, which enables the user to enter, edit, and display data as 

needed.  Use of the database satisfies the need to store individual contact information, 

individual scores, team scores, individual and team relationships, league schedules, and 

handicaps.  

 The interface was written using Microsoft Visual Basic 6.0 and provides the 

ability, via ADO commands, to enter individual data and team data into the database. It 
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also provides the capability to recall, display, and print data as requested by the user 

(league standings, individual scores, team scores, average scores, team members, etc.).  

In addition, the interface provides the calculation function for handicaps, shooter 

statistics, league leaders, and the league schedule. 

2.1 User Profile 
 
 The intended target audience for this software package is the three million trap 

and skeet shooters in North America.  This program is intended for use by those who 

manage or perform statistician’s duties (such as league secretaries) for local trap and 

skeet shooting leagues.  The level of computer literacy the targeted users possess should, 

at a minimum, be the ability to install, understand, and work with graphical user interface 

programs.  In many cases, the users’ proficiency levels may exceed this minimum 

requirement, but the focus is to provide to targeted users who use desktop computing 

systems a software package that is intuitive and simple to use. 

2.2 Design Protocols 
 
2.2.1 Interface 
 

  The software package is designed around a standard user interface found in most 

Windows-compatible programs. By using command buttons and drop-down menus on 

the displayed forms, the user is able to navigate to other forms that display data, generate 

programmed responses, apply calculating criteria, manipulate data, and store any changes 

made to the data.  Execution of this project was on a Microsoft Windows 2000 

Professional platform using Microsoft Access 2000 and Microsoft Visual Basic 6.0 

Enterprise Edition.  Hardware consists of an AMD Duron 700 MHz computer with 128 

MB RAM.  The hardware and software platform were chosen for speed, cost, availability, 
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and reliability.  The programming environment and database program were chosen for 

familiarity, availability and ease of use. 

2.2.2 Graphical Symbols 
 

  The use of graphical symbols as key points of interaction is minimized within 

this product with the following exceptions: 

1) <<, <, >, >>:  These symbols are used as shooter record navigation 
icons within the Shooter Information module of the program, allowing 
the user to move forward or backward through the records or jump to 
the first or last record as needed. 

 
2) <<, <, >, >>:  Within the Edit Team, Create Team, Edit League, and 

Create League modules, these symbols provide shooter or team 
assignment capabilities by moving selected shooters or teams from one 
list to another or by moving all list members from one list to another 

 
3) Toolbar Icons:  Standard toolbar icons (such as Print, New File, and 

Open File) are used and retain the same meaning and function as found 
in most Windows-compatible programs. 

 
2.2.3 Color Scheme 
 

A standard Windows color scheme is used.  Form foreground and background 

colors are black and light gray, respectively.  Highlighting and title bar colors are 

determined by the user’s desktop setting. 

2.2.4 Help System 
 

A help system (available through the “Help” drop-down menu on the main form) 

is provided to aid new users in creating leagues, teams, players, generating match 

schedules, entering scores, editing scores, applying handicaps, displaying shooter, team, 

league, scoring, and scheduling data.  
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2.2.5 Program Organization 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.  Program Organization 
 

Main Form: Shows 
Summary of league 
information, provides 
menus to access rest 
of program 

File 
functions 

Tools Help 

New 
Open 
Exit Program 

Shooter Information 
League Menu 
Team Menu 
Schedule Editor 
Displays 
Enter Scores 

Help Index 
About… 

Displays 
Shooter Info – 
ability to 
edit/add 
shooters to 
database 

Displays 
League Info- 
ability to edit 
league info 

Displays 
Team Info- 

ability to edit 
Team info 

Displays 
Schedule for 

selected 
league – 

ability to edit 
schedule 

Add League 
Module Generate 

Schedule 
Module 

Create Team 
Module 

Enter Score Module – allow for 
display of players current 

statistics, handicap, adjusted 
scores, raw scores, and use of 

substitute shooters 

Displays –  
   Team List 
   Shooter List 
   League Statistics 
   League Results 
   League Schedule 

Scoring Rules – Set 
point values for 
scoring 

Database 



7 

3. Deliverables 
 
 Using Mr. Niner’s recommendations as a guideline, the final product meets or 

exceeds the following criteria and functionalities: 

1. Possesses full access to custom designed database containing the following the 
tables and data 

a. ShooterData Table 
1. Shooter ID (Primary Key) 
2. First Name 
3. Last name 
4. Street Address 
5. City 
6. State 
7. ZIP Code 
8. Phone Number 
9. Email Address 
10. Emergency Contact Name 
11. Emergency Contact Phone Number 

b. LeagueData Table 
1. League ID (Primary Key) 
2. League Name 
3. Skeet (Yes/No) 
4. Trap (Yes/No) 
5. League Duration 
6. Total Number of Matches 
7. Handicap Variable 
8. Number of Targets 
9. Maximum Handicapped Score 
10. Trap Points 
11. Skeet Points 
12. Birds Points 
13. Bye Points 
14. Tie Points 

c. TeamData Table 
1. Team ID (Primary Key) 
2. Team Name 
3. League ID (Foreign Key for associative purposes) 
4. Total Points 
5. Total Birds 

d. ShooterTeamData (Correlates a Shooter with a Team) 
1. Shooter ID 
2. Team ID 
3. Current Handicap 
4. Average 
5. Total Birds 
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e. ScheduleData Table 
1. League ID 
2. Team1 ID 
3. Team2 ID 
4. Week Number 
5. Date ID 

f. ScoreData Table 
1. League ID 
2. Team ID 
3. Shooter ID 
4. Trap Score 
5. Skeet Score 
6. Handicapped Trap Score 
7. Handicapped Skeet Score 
8. Date ID 

g. DateData Table 
1. Date ID (Primary Key) 
2. Date 
3. League ID 

h. TeamTotal Table 
1. Team ID 
2. Date ID 
3. Trap Total 
4. Skeet Total 

2. Provides a visual interface built using Visual Basic 6.0 that has the following 
functionality: 

a. Summary Screen 
1. Provides a quick summary of league name, handicap, type, and 

duration (should be league selectable) 
2. Provides a quick list of Teams associated with each League, 

Shooters associated with each Team, and address of Shooter when 
League, Team, and Shooter are selected respectively 

3. Provides drop-down menus to provide access to more functionality 
modules: Edit/Create League, Edit/Create Team, Shooter 
Information, Enter/Edit Scores, and Edit/Display Schedule 

b. Edit/Create League Module allows user to: 
1. Create a new League by providing functionality to add new league 

name, type, duration, matches, and handicap to database 
2. Access Edit Teams module to allow for assignment of teams to new 

league or to change existing leagues’ team composition 
3. Edit existing league information (league name, type, duration, 

handicap, and total matches) and save those changes to the database 
4. Provide access to Schedule Generator and Edit/Display Schedule 

Modules 
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c. Edit/Create Team Module allows user to: 
1. Edit team name and shooter composition (including adding and/or 

removing shooters) and save these changes to the database 
2. Add a new team to the database and associate shooters to that team 

within the database 
3. Select league and view teams and shooters associated with that 

league 
d. Shooter Information allows the user to: 

1. Browse through the database collection of shooters and view all 
personal information associated with that shooter (name, address, 
phone number, emergency contact information) except for 
league/team/score information to allow for the possibility that 
shooters may members of more than one team or league 

2. Edit shooter information and save changes to the database 
3. Add new shooters to the database (including all required 

information) 
e. Schedule Editor Module allows the user to: 

1. Adjust the selected league’s schedule by changing match dates 
2. Adjust the selected league’s schedule by changing team match ups 
3. Save any changes to the database 
4. Display the selected league’s schedule 

f. Enter/Edit Score Module allows the user to: 
1. Enter scores for matches by selecting league, team, shooter and 

match date 
2. View entered scores as Raw score and as adjusted by Handicap 
3. Change Handicap variable 
4. Display shooter scores for current league 

g. Display Module allows the user to: 
1. View the schedule for a selected league 
2. View team and shooter standings and statistics for a selected league 

(team rankings, best scores, best/worst team score, average team 
score, last match shooter performance) 

3. View score history for entire league ordered by teams and shooters 
(placement determined by current standing within the league) 

4. Select a time frame for these views 
5. Print these views 
6. Save these views to a text file 

  
4. Design and Development 

 
This program was developed using Microsoft Visual Basic 6.0 as the code base 

for the interface and Microsoft Access 2000 for the database design.  The interface forms 

and controls are totally unbound and the database is accessed using ADO command code.  
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This design was implemented to allow the prospective user to store the database in any 

location, either another directory or a floppy disk.  This allows the user to install the 

program on different systems and to move the database between both platforms if 

desired.  Appendix A. presents budget considerations for this program.  Appendix B. lists 

the scheduled followed in the development of this program.  Appendices C. and D. 

present the software and hardware used for development respectively.  

5. Proof of Design 
 
5.1 Database 
 

The database created with Microsoft Access 2000 consists of the tables, fields, 

and relationships shown in Figure 2. 

 

Figure 2. Database Structure and Relationships 
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5.2 Interface 
 
5.2.1 The Main Form 
 
 The main form acts as a container for all other forms (Figure 3.) 

 

Figure 3.  Main Form 
 

 Through use of the drop-down menus, the user can: open a new file, open an 

existing file, use the tools menu to open other parts of the program, arrange open 

windows, and access the about form and the Help system (Figures 4. and 5.). 
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Figure 4. File Menu 

 

Figure 5. Primary Tools Menu 
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5.2.2 The Summary Window 
 
  The Summary Window provides a quick summary of league name, handicap, 

type, duration (in weeks), and the dates the league runs.  It also provides a quick list of 

Teams associated with each League, Shooters associated with each Team, and address of 

Shooter when League, Team, and Shooter are selected from the respective list.  A 

command button is included on the form that will show the currently selected leagues 

schedule when clicked.  The text boxes are loaded by ADO command calls to the 

database. 

 

Figure 6. Summary Window 
 
5.2.3 League Administrator Window 
 

By using the Tools Menu, the user can access all other forms in the program aside 

from the About and Help forms.  The League Administrator Window allows the user to 
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add a new league to the database by clicking the Add League button.  All text boxes on 

the form are then cleared and the user enters the appropriate data in the text boxes.  When 

done, the user clicks the Save button and the information on the form is written to the 

database as a new record via ADO commands. 

 

Figure 7. League Administrator Window – adding a new league 
 
Once the league is saved to the database, the user can then edit the league, generate a 

schedule, view a schedule, edit a schedule, assign teams, or set the scoring rules by 

clicking the proper button on the League Administrator. 

5.2.4 Scoring Rules 
 
 The Scoring Rules Window allows the user to set the point values for a win in 

Skeet competition, Trap competition, highest total birds shot, in case of ties, and in case 
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of byes.  These values are then saved top the database and associated with this league 

only.  The values are used to calculate results of competition. (Figure 8.) 

 

Figure 8. Scoring Rules 
 
5.2.5 Assign Teams 
 
 After setting the initial league parameters, teams must be created and assigned to 

compete within the new league.  See 5.2.8 for more information. 

5.2.6 Schedule Generator 
 
 Once at least two teams have been assigned to compete in the league, the user can 

then generate a schedule for the competition by clicking on Generate Schedule.  This 

action brings up the Date Selection Window.  The user selects competition dates from the 
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calendar on the form and then clicks Generate Schedule.  The schedule is then 

automatically generated and the Edit Schedule Window opens. 

 

Figure 9. Schedule Generator 
 
5.2.7 Schedule Editor 
 
 The Edit Schedule Window allows the user to view the generated schedule and 

make changes to the schedule.  The user can change the dates of competition or the 

composition of the matches themselves.  Editing is accomplished by selecting a cell and 

typing the change wanted.  Double-clicking the cell will also open the cell for editing.  

Clicking the Save Changes button will save all changes to the database.  See Figure. 10. 
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Figure 10. Edit Schedule Window 
 
5.2.8 Team Manager 
 
 Access to the Team Manager Window is either by the Tools Menu or by clicking 

Assign Teams when in the League Administrator Window.  In this window, the user can 

add or remove members form existing teams by using the <, <<, >>, or > buttons.  In the 

case of < or >, only the currently selected shooter will be added or removed respectively.  

Using << or >> will add or remove all shooters in the list.  Once changes to the current 

team are completed, the user clicks the Save button to save the changes.   
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Figure 11. Team Manager Window 
 
5.2.9 Team Builder 
 
 Clicking the Add Team button on the Team Manager accesses the Team Builder 

Window.  On this screen, the user can create a new team in the selected league and assign 

shooters to that team.  The operation of the screen is similar to the Team Manager but 

includes a textbox to enter the new teams name.  Once the user clicks Save Team, the 

team and its members are saved to the database.  The user can also access the Shooter 

Information Screen in order to add shooters to the database while building a team. 
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Figure 12. Team Builder 
 
5.2.10 Shooter Information Screen 
 
 Accessible by either the Tool menu or the Team Builder Window, the Shooter 

Information Screen allows the user to move forwards or backwards through the 

ShooterData table in the database.  All information for each shooter record is presented 

and the user, if they so desire can edit the information shown.  The user can also add new 

shooters to the database.  
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Figure 13. Shooter Information Window 
5.2.11 Scoresheet Screen 
 
 Available through the Tools menu, this screen allows the user to enter or edit the 

scores shooters obtained during competition.  The input screen is designed around an MS 

FlexGrid.  This presents the team members and dates of competition when a team name is 

selected from the list.  The user can then enter or edit the scores on the grid as necessary.  

Clicking the Save button saves all data to the database.  The user can also select whether 

to view the scores as raw scores or handicap adjusted scores by using the option button 

provided.  The user can also adjust the handicap variable. 
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Figure 14. Scoresheet 
 

The user can also assign substitute shooters to the selected team at this time.  The 

substitute and their scores are associated only with the selected team on that date.  The 

substitute, if a member of another team, can still shoot for his own team and the scores 

will not affect each other (See Figure 14). 

5.2.12 Displays 
 
 The Displays item under the Tools menu provides a sub-menu with several 

choices for the user.  The user can see a static view of teams, shooters, schedules, 
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statistics, shooter standings, team standings, and a score summary.  The desired 

information appears on a form consisting of only a textbox.  The text box contains the  

 

Figure 15. Scoresheet – add substitute 
requested information. The textbox is scrollable, so the user can see all parts of the text, 

and it is editable, allowing the user to format the text as needed.  A new File menu 

appears when this window opens.  This menu allows the user to save a display as a file, 

open a previously saved display, a printer set-up option, and the print 0ption.  The print 

option prints the display as it appears on the screen.  Samples of displays available can be 

seen in Figures 15. – 19. 
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Figure 16. Display – Shooter List 

 

Figure 17. Display – Team List 
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Figure 18. Display - League Statistics 

 

Figure 19. Display - Team Standings 
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Figure 20. Display - Shooter Standings 

 
5.2.13 League Results Screen 
 
 The League Results Screen (Figure 20) displays the scores, handicaps, and 

averages of shooters by week, as chosen by the user.  It also shows the total trap, skeet, 

and bird counts each team acquired.  These totals are used to determine the winner of 

each match that week.  The display is arranged by matches and the results are posted by 

each teams’ listing at the right edge of the screen.  If a skeet and trap league has been 

formed, the winners of each individual competition (trap or skeet), as well as the total 

bird winner, are displayed next to the team that had the highest total in each category for 

each match.  The display is scrollable to ensure that all parts can be seen and a Print 

Preview button is provided to allow the use to see the results as it would be printed and to 

format the display as need. 
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Figure 21. League Results 
 
5.2.14 Score Summary 

 The Score Summary screen presents all the scores shot by each competitor, listed 

by teams.  The average, handicap, and total birds broke are provided in the last three 

columns.  The user cannot edit this screen, but a Print Preview button is provided 

allowing the user to format the display for printing.  The screen can only show one type 

of competition at a time, either skeet or trap, but not both simultaneously.  A scrollable 

list box is provided and lists the types of competition for the league.  When the user 

selects another type of competition, the display will then display the scores, averages, 

handicaps, and total birds broke for that type of competition. (See Figure 22.) 
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Figure 22. Score Summary 
 
5.3 Help File 

 A help file is provided to aid the user in the use of this program.  The Help file is 

accessible through the Help dropdown menu.  The Help file was created using Help 

Workshop included with Microsoft Visual Basic 6.0, Enterprise edition.  It uses the 

WinHelp32.exe engine to display the help file in the familiar Microsoft Windows Help 

File format.  Contents, indexing, and searching are enabled.  See Figure 23.  and Figure 

24. 
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Figure 23. Help Screen – Contents 

 

Figure 24. Help Screen - Sample Help File 
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6 Conclusions and Recommendations 

 As research shows, a need exists for a software package that can aid a skeet and 

trap league manager in recording and manipulating the data he collects during a league 

season.  The execution of this project has fulfilled that need and enabled the league 

manager to concentrate on running the league without having to learn spreadsheet 

programming or keeping records by hand.  I believe that PerfectShot is a useful tool for 

anyone managing a trap and skeet league.  It eases the problems of record storage and 

calculations that have plagued league managers for years.  PerfectShot is a versatile 

program with possible applications in other shooting sports, such as center-fire pistol 

competitions, sporting clays, and rifle marksmanship competitions.   

 Future versions of this program should include the ability to delete a shooter, 

team, or league from the database and to enable support of standard teams so that the user 

can use the same team in separate leagues without having to completely rebuild the team 

for each league.  Enhancements should also include the ability to export the displays into 

a comma-delimited format for import to a spreadsheet program or into HTML format for 

display on a web site.  The option to override the calculated handicapped score would 

allow the user greater freedom in scoring formats.  The displays could be altered to allow 

the user to set a limit option in how many shooters are displayed on the Shooter Standing 

Display.  The program could also be redesigned to allow multiple users with differing 

access levels to use the program.  This last option would be a precursor to redesigning the 

program as a web-enabled application. 

The ability to save a database file under a different filename would make backing 

up a database easier but, unfortunately, this was not possible to implement.  Several 
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methods of saving files were investigated, including API calls, batch file programming, 

FileCopy method of Visual Basic, and shell commands.  The same error was encountered 

with each method.  If, during a current running of the program, the program accesses a 

database file, that database file cannot then be saved from within the program.  The error 

encountered was a file permission error.  Further study into the cause of this should be 

made.  The problem may be operating system based. 
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Appendix A. 

Budget 

 

Software: Microsoft Windows 98, Second Edition $209.00  (5) 
 MS Access 2000 339.00  (5) 
 MS Visual Basic 6, Enterprise Edition 1299.00  (5) 
    
Hardware: AMD Duron 700 MHz Computer 214.00  (3) 

 128 MB PC133 SDRAM 87.00  (4) 
 17” Monitor 177.00  (1) 
 Western Digital 20 GB HDD 99.00  (9) 
 Total: $2424.00  
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Appendix B. 

Project Schedule 

Phase:         Start       End 
• Research     10/05/00  06/08/01 

o Skeet Shooting Rules and Scoring 
o Trapshooting Rules and Scoring 
o Database Design / ADO implementation 
o Visual Basic programming 
o Graphical interface design considerations 
o Database Design/Construction  11/06/00  12/06/00 
o Create ShooterData Table   11/06/00  11/06/00 
o Create LeagueData Table   11/06/00  11/06/00 
o Create TeamData Table   11/06/00  11/07/00 
o Create ScheduleData Table  11/06/00  11/06/00 
o Create ScoreData Table   11/06/00  11/10/00 
o Populate Database    11/27/00  12/06/00 
o Continuous Redesign   11/06/00  05/08/01 

• Interface Design/Coding   11/06/00  05/08/01 
o Main Form Module   11/06/00  11/13/00 
o Shooter Information Module  11/13/00  11/20/00 
o Edit Team Module   11/20/00  12/20/00 
o Create Team Module   01/01/01  01/15/01 
o Edit League Module   01/15/01  01/22/01 
o Create League module   01/22/01  01/29/01 
o Enter Scores Module   01/29/01  02/21/01 
o New/Open/Save Routines   02/21/01  02/23/01 
o Schedule Generator   02/23/01  03/01/01 
o Edit Schedule Module   03/01/01  03/05/01 
o Display Schedule Module   03/05/01  03/12/01 
o Display League Stats   03/12/01  03/19/01 
o Display Team Stats   03/19/01  03/26/01 
o Display Shooter Stats   03/26/01  03/29/01 
o Display Scores    03/29/01  05/12/01 
o Print Schedule Module   04/12/01  04/17/01 
o Testing/Debugging  In accordance with module completion 

 
Dates are subject to change as project modules are completed early or as redesign 

may require 
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Appendix C. 

Software 

Operating Systems Comments 
 

Microsoft Windows 2000 Professional Edition Problem: Unable to copy previously opened 
database to a new filename 
 

Microsoft Windows Millennium Edition Problem: Unable to copy previously opened 
database to a new filename 
 

Microsoft Windows 98, Second Edition Problem: Unable to copy previously opened 
database to a new filename 
Problem: Must include DCOM98.EXE when 
installing program to provide Jet Database 
access 
 

Microsoft Windows 95, Version B Problem: Unable to copy previously opened 
database to a new filename 
Problem: Must include DCOM95.EXE when 
installing program to provide Jet Database 
access 

 

Other software used: 

Microsoft Visual Basic 6.0, Enterprise Edition  

Microsoft Access 2000 

RoboHelp 9.0 
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Appendix D. 

Hardware 

 

Development and Testing Platforms Location Operating Systems 
 AMD Duron 700 MHz Computer Home Windows Millennium 
 128 MB PC133 SDRAM   
 20 GB HDD   
 17” Monitor   
    
 Pentium III 600 MHz Computer CAS, A401 Windows 2000 Professional 
 256 MB PC100 SDRAM   
 20 GB HDD   
 17” Monitor   

 

Testing Only Platform Location Operating Systems 
 Pentium 120 MHz Computer Home Windows 98 SE 

 32 MB RAM  Windows 95b 
 6.7 GB HDD   
 15” Monitor   
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